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Preface
Welcome to the Gplus Adapter 7.5 Campaign Synchronization for SAP 
Deployment Guide. This document lists system requirements, and describes 
how to install and configure the Gplus Adapter Campaign Synchronization for 
SAP (the Adapter).

Note: For versions of this document created for other releases of this product, 
please visit the Genesys Technical Support website, or request the 
Documentation Library CD, which you can order by e-mail from 
Genesys Order Management at orderman@genesyslab.com. 

This preface provides an overview of this document, identifies the primary 
audience, introduces document conventions, and lists related reference 
information. It contains the following sections: 
• New in Release 7.5, page 8
• Intended Audience, page 9
• Chapter Summaries, page 9
• Document Conventions, page 10
• Related Resources, page 12
• Making Comments on This Document, page 13
The Adapter extends the SAP product suite with enhanced telesales and 
telemarketing campaign functionality. For example, it enables dynamic 
updating to active outbound campaigns and reporting on post-campaign dialing 
results. 

mailto:orderman@genesyslab.com
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Preface New in Release 7.5

New in Release 7.5
The Gplus Adapter 7.5 Campaign Synchronization for SAP is the replacement 
product for the 6.5 Gplus Outbound Adapter for SAP. The 7.5 Adapter has the 
following capabilities:

Functional

• Calling List creation and update
The Adapter enables the transfer of outbound calling list data between SAP 
and Genesys. 

• Call List updates triggered by an inbound call
The Adapter allows for Call Lists to be updated as a result of an inbound 
call. For example, if a customer calls (even while they are an outbound 
campaign target) the Call List data will be updated with the caller’s latest 
information.

• Campaign record deletion
The Adapter allows for the programmatic deletion of Outbound Campaign 
Records between SAP and Genesys. 

• Campaign results query
The Adapter exposes campaign results, which can be programmatically 
queried from SAP to Genesys.

Platform

• Operating system support
The Adapter supports Microsoft Windows Server 2000 and 2003. 

• Database support
The Adapter supports MS SQL Server 2000, 2005; and, Oracle 9.2, 10g. 

Usability

• Multi-instance support
Multiple- instances of the Adapter can operate on the same or different 
computer. 

• Run as Windows Service
The Adapter can now be operated as a MS Windows Service. 

High Availability

• Genesys Configuration Server Primary (Backup) support
The Adapter supports Primary (Backup) mode of Configuration Server for 
access to the configuration data. 
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Security

• Transport layer security
The Adapter supports a secure connection with Genesys Configuration 
Server, and DB Server. 

Intended Audience
This document is intended primarily for system administrators or other 
individuals who install, configure, and maintain the Adapter. The guide 
assumes that you have a basic understanding of:
• Computer-telephony integration (CTI) concepts, processes, terminology, 

and applications.
• Network design and operation.
• Your own network configurations.
You should also be familiar with: 
• Genesys Framework architecture and functions

Chapter Summaries
In addition to this preface, this Deployment Guide contains the following 
chapters: 
• Chapter 1, “About the Adapter,” on page 15, introduces the concepts, 

terminology, key features, and architecture for the Adapter.
• Chapter 2, “System Requirements,” on page 19, describes the minimum 

hardware and software requirements for installing and using the Adapter.
• Chapter 3, “Migration,” on page 23, describes the requirements and 

process for migrating from the 6.5 Gplus Outbound Adapter for SAP to 
Gplus Adapter Campaign Synchronization for SAP 7.5.

• Chapter 4, “Configuring Campaign Synchronization Server,” on page 27, 
describes configuration tasks for the Adapter’s Campaign Synchronization 
Server (CSS) component.

• Chapter 5, “Installing Campaign Synchronization Server,” on page 41, 
describes installation tasks for the Adapter’s Campaign Synchronization 
Server (CSS) component.

• Chapter 6, “Configuring the Autodialing Gateway Server for SAP,” on 
page 45, describes configuration tasks for the Adapter’s Autodialing 
Gateway Server for SAP (AGS) component.

• Chapter 7, “Installing Autodialing Gateway Server for SAP,” on page 61, 
describes installation tasks for the Adapter’s Autodialing Gateway Server 
for SAP (AGS) component.
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• Chapter 8, “Starting the Adapter Components,” on page 65, describes how 
to start the Adapter’s CSS and AGS components.

• Chapter 9, “Use-Case Scenarios,” on page 71, provides several use-case 
scenarios about using the Adapter.

Document Conventions
This document uses certain stylistic and typographical conventions—
introduced here—that serve as shorthands for particular kinds of information.

Document Version Number

A version number appears at the bottom of the inside front cover of this 
document. Version numbers change as new information is added to this 
document. Here is a sample version number:
75gp_dep_sap-campsynch_03-2007_v7.5.001.00

You will need this number when you are talking with Genesys Technical 
Support about this product.

Type Styles

Italic

In this document, italic is used for emphasis, for documents’ titles, for 
definitions of (or first references to) unfamiliar terms, and for mathematical 
variables.

Examples: • Please consult the Genesys 7 Migration Guide for more information.
• A customary and usual practice is one that is widely accepted and used 

within a particular industry or profession.
• Do not use this value for this option.
• The formula, x +1 = 7 where x stands for . . .

Monospace Font

A monospace font, which looks like teletype or typewriter text, is used for 
all programming identifiers and GUI elements. 
This convention includes the names of directories, files, folders, configuration 
objects, paths, scripts, dialog boxes, options, fields, text and list boxes, 
operational modes, all buttons (including radio buttons), check boxes, 
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commands, tabs, CTI events, and error messages; the values of options; logical 
arguments and command syntax; and code samples.

Examples: • Select the Show variables on screen check box.
• Click the Summation button.
• In the Properties dialog box, enter the value for the host server in your 

environment.
• In the Operand text box, enter your formula.
• Click OK to exit the Properties dialog box.
• The following table presents the complete set of error messages 

T-Server distributes in EventError events.
• If you select true for the inbound-bsns-calls option, all established 

inbound calls on a local agent are considered business calls.
Monospace is also used for any text that users must manually enter during a 
configuration or installation procedure, or on a command line:

Example: • Enter exit on the command line.

Screen Captures Used in This Document

Screen captures from the product GUI (graphical user interface), as used in this 
document, may sometimes contain a minor spelling, capitalization, or 
grammatical error. The text accompanying and explaining the screen captures 
corrects such errors except when such a correction would prevent you from 
installing, configuring, or successfully using the product. For example, if the 
name of an option contains a usage error, the name would be presented exactly 
as it appears in the product GUI; the error would not be corrected in any 
accompanying text.

Square Brackets

Square brackets indicate that a particular parameter or value is optional within 
a logical argument, a command, or some programming syntax. That is, the 
parameter’s or value’s presence is not required to resolve the argument, 
command, or block of code. The user decides whether to include this optional 
information. Here is a sample:
smcp_server -host [/flags]

Angle Brackets

Angle brackets indicate a placeholder for a value that the user must specify. 
This might be a DN or port number specific to your enterprise. Here is a 
sample:
smcp_server -host <confighost>
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Related Resources
The following Genesys and SAP resources are required to install and configure 
the Adapter.

Genesys Resources
Consult the following additional Genesys resources as necessary:
• Genesys Guides including:

Genesys 7.5 Security Deployment Guide
Framework 7.5 Deployment Guide
Outbound Contact 7.5 Deployment Guide
Outbound Contact 7.5 Reference Manual

• The Genesys Technical Publications Glossary, which is included on the 
Genesys Documentation Library CD. This document provides a 
comprehensive list of the Genesys and CTI terminology and acronyms 
used in this document.

• The Genesys 7 Migration Guide, also on the Genesys Documentation 
Library CD, which provides a documented migration strategy from 
Genesys product releases 5.1 and later to all Genesys 7.x releases. Contact 
Genesys Technical Support for additional information.

• The Release Notes and Product Advisories for this product, which are 
available on the Genesys Technical Support website at 
http://genesyslab.com/support. 

Information on supported hardware and third-party software is available on the 
Genesys Technical Support website in the following documents: 
• Genesys Supported Operating Systems and Databases 
• Genesys Supported Media Interfaces 
Genesys product documentation is available on the:
• Genesys Technical Support website at http://genesyslab.com/support.
• Genesys Documentation Library CD, which you can order by e-mail from 

Genesys Order Management at orderman@genesyslab.com. 

SAP Resources
To access related SAPphone specification documents contact your SAP 
administrator.

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=A9CB309AF4DEB8127C5640A3C32445A7&view=item
http://genesyslab.com/support
mailto:orderman@genesyslab.com
http://genesyslab.com/support
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Making Comments on This Document
If you especially like or dislike anything about this document, please feel free 
to e-mail your comments to Techpubs.webadmin@genesyslab.com. 
You can comment on what you regard as specific errors or omissions, and on 
the accuracy, organization, subject matter, or completeness of this document. 
Please limit your comments to the information in this document only and to the 
way in which the information is presented. Speak to Genesys Technical 
Support if you have suggestions about the product itself.
When you send us comments, you grant Genesys a nonexclusive right to use or 
distribute your comments in any way it believes appropriate, without incurring 
any obligation to you.

mailto:techpubs.webadmin@genesyslab.com
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Chapter

1 About the Adapter
The Gplus Adapter 7.5 Campaign Synchronization for SAP is the replacement 
product for the 6.5 Gplus Outbound Adapter for SAP. It is intended for 
customers running SAP CRM 3.0 (or later), and specifically for SAP systems 
that support outbound campaign functionality, including:
• Interaction Center Call List Management Application (for supervisors)
• Interaction Center WinClient
• Interaction Center WebClient
This chapter provides an overview of the Adapter, its features, and its 
architecture. This chapter contains the following sections:

Feature Overview, page 15
Architectural Overview, page 17

Feature Overview 
The Adapter interfaces with the Genesys Outbound Contact Solution (OCS) 
and SAP CRM. It consists of two components:
• Autodialing Gateway Server for SAP (AGS)
• Campaign Synchronization Server (CSS)
The Adapter complements the SAP product line by enabling:
• Automatic dialing capability
• Inbound and outbound interactions for customer agents 
• Statistical campaign capability such as Progressive and Predictive, which 

are popular among large enterprises such as typical SAP customers.
• External organizations and administrators connectivity.
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Key Features
The Adapter enables the following key features:
• Integration between Genesys and SAP to enable campaign synchronization 

functionality. Specifically, the Adapter can be configured to:
Enable Calling List creation and updating so that the SAP system can 
submit or modify outbound campaigns in OCS. 
Enable Call List updating during an inbound call (where the request for 
the update is initiated by the Agent that received the inbound call).
Provide offline and online campaign record deletion. so that the SAP 
system can delete campaign records in OCS. 
Provide querying of campaign results so that the SAP System can 
query the results and statistics of campaigns in OCS.

• Adapter components (CSS and AGS) configuration using the Genesys 
Configuration Layer, to enable easy configuration for system 
administrators.

• Adapter components (CSS and AGS) administration from the Genesys 
Management Layer, to enable remote starting, stopping, status viewing, 
and centralized logging.

External Organizations and Administrators 
The Adapter supports a one-to-many relationship between Genesys and 
external systems. For example, one instance of Genesys can be configured to 
work with either:
• Many SAP Systems
• One SAP System that has many clients. 
This functionality is configured in the CSS and AGS components. For more 
information about how to configure the CSS component, see the:
• “Tenants Section” on page 36
• “CallingListFolders Section” on page 32
• “DatabaseAccessPoints Section” on page 34
• “TableAccessFolders Section” on page 35 and see AGS options
For more information about how to configure the AGS component, see the 
CampSync Section:
• Organization option on page 54
• Admin option on page 54
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Architectural Overview
Genesys and SAP are integrated through the following Adapter components:
• Campaign Synchronization Server (CSS)
• Autodialing Gateway Server for SAP (AGS), as shown in Figure 1

Figure 1: Architectural Overview

The Adapter components provide the following functionality:
• Autodialing Gateway Server for SAP implements the automated dialing 

behavior of SAPphone RFC interface (across SPS_PDLISTTRANSFER, 
SPS_STATCAMPAING, and SPS_DELETE_PDCALL SAP RFC functions).

• Campaign Synchronization Server provides campaign synchronization 
functionality for OCS. 

The Adapter interacts with Genesys Configuration Layer, Management Layer, 
and Genesys Database Server using Genesys libraries and APIs. 
The Adapter components maintain the following connections:
• AGS and CSS maintain a connection to the Configuration Layer and the 

Management Layer.
• AGS maintain a connection to CSS (to enable transfer of SAP requests).
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• AGS maintain a connection to the SAP server (to enable processing of 
automated dialing RFC requests).

• CSS connects to Genesys Outbound Contact Server and T-Server.
• AGS and CSS maintain a connection to DB Server (after the first request 

from the SAP System).
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Chapter

2 System Requirements
This chapter outlines the minimum software and hardware requirements for the 
Gplus Adapter Campaign Synchronization for SAP. It contains the following 
sections:

Compatibility Overview, page 19
Software Requirements, page 20
Hardware Requirements, page 21

Compatibility Overview
The Adapter requires the following:
•   Operating system
•   Genesys Framework
•   Relationship Database Management System (RDBMS)
•   SAP System that supports the Remote Function Calls (RFC) protocol and 

  SAPphone interface.
Information on supported hardware and third-party software is available on the 
Genesys Technical Support website in the following documents:
• Genesys Supported Operating Systems and Databases
• Genesys Supported Media Interfaces

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054
http://genesyslab.com/support/dl/retrieve/default.asp?item=A9CB309AF4DEB8127C5640A3C32445A7
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Software Requirements
You will need the following software to support the Adapter:
•   Genesys Framework 7.5
•   SAP CRM Application Server and SAP GUI client
•   An operating system, see the Genesys 7 Supported Operating Systems and 

  Databases Reference Manual for details.

Genesys Applications
The following Genesys software is required:
•   Genesys Framework 7.5, including:

Configuration Layer (Configuration Server, Configuration Manager, 
and so on) 
Management Layer (LCA, Message Server, Solution Control 
Server/Interface, and so on)
Genesys Outbound Contact Solution

Note:  For best performance, install the Genesys applications on different 
machines. For installation information, refer to the documentation for 
the specific application.

SAP Applications
You will need to complete the setup described in the following SAP 
documentation to deploy and use the Adapter:
• SAP Note 413708. 
• SAP Note 1023194
• SAPphone Documentation

SAP Note 413708

Autodialing Gateway Server for SAP uses librfc32.dll (part of the SAP RFC 
library). Refer to SAP Note 413708 for details on how to deploy the SAP RFC 
SDK. 

Note: This configuration should be performed by a SAP Administrator.
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SAP Note 1023194

If you are using SAP CRM 4.0 there is a code adjustment required to the SAP 
System. Refer to SAP Note 1023194 for details.

Note: This configuration should be performed by a SAP Administrator.

SAPphone Documentation

The Adapter communicates with the SAP system by means of the SAPphone 
interface. See the SAPphone documentation for SAPphone requirements. This 
version of the Adapter implements SAPphone Interface version 5.11.

Relational Database Management System (RDBMS)
You will need a Relational Database Management System to deploy and use 
the Adapter. See, the Genesys 7 Supported Operating Systems and Databases 
Reference Manual for details.

Hardware Requirements
You need the following hardware to support the Adapter (CSS and AGS):
• Pentium III 700 Mhz CPU or faster 
• 256 MB of RAM 
• 64 MB of disk space 
• 800 × 600 256-color monitor or higher 
• Network adapter and network connection 
These are minimum hardware requirements. For large call centers and/or large 
call volumes, more hardware resources (especially RAM and CPU) will be 
required.
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3 Migration
This chapter provides a summary of the steps to migrate from the 6.5 Gplus 
Outbound Adapter for SAP to the Gplus Adapter Campaign Synchronization 
for SAP 7.5. It contains the following sections: 

Overview of Migration Steps, page 23
Deactivating SAP Campaigns, page 24
Deleting Calling List and Table Access Objects from Genesys 
Configuration DB, page 24
Uninstalling the 6.5 Gplus Outbound Adapter for SAP, page 24
Upgrading to Genesys Framework 7.5, page 25
Upgrading to Genesys Outbound Contact 7.5, page 25
Importing the 7.5 Adapter Component Templates, page 25
Creating the 7.5 Adapter Component Applications, page 25
Configuring the 7.5 Adapter Components, page 26
Installing the 7.5 Adapter Components, page 26
Starting the Adapter Components, page 26
Activating the SAP Calling Lists, page 26

Overview of Migration Steps
Migration from the 6.5 Adapter to the 7.5 Adapter requires the following steps:
1. Deactivating SAP Campaigns
2. Deleting Calling List and Table Access Objects from Genesys 

Configuration DB
3. Uninstalling the 6.5 Gplus Outbound Adapter for SAP
4. Upgrading to Genesys Framework 7.5
5. Upgrading to Genesys Outbound Contact 7.5
6. Importing the 7.5 Adapter Component Templates
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7. Creating the 7.5 Adapter Component Applications 
8. Configuring the 7.5 Adapter Components
9. Installing the 7.5 Adapter Components 
10. Starting the Adapter Components
11. Activating the SAP Calling Lists

Deactivating SAP Campaigns
See Chapter 9, “Use-Case Scenarios,” on page 71 for details.

Deleting Calling List and Table Access 
Objects from Genesys Configuration DB

Using Genesys Configuration Manager, delete all Calling List and Table 
Access objects that were created by the 6.5 Adapter. 

Uninstalling the 6.5 Gplus Outbound 
Adapter for SAP

You can uninstall the 6.5 Adapter using the Microsoft Windows Add/Remove 
Programs feature.
To completely uninstall the 6.5 Adapter:
1. From the Windows main taskbar, select Start > Settings > Control 

Panel > Add/Remove Programs.
2. Select Genesys Outbound Adapter for SAP as the component to remove.
3. Follow the instructions on screen, and confirm that you want to remove the 

Adapter components.
Add/Remove Programs removes the Adapter components.

4. After you see the message that says that the uninstall has been completed, 
follow the instructions on screen to conclude the uninstall process.

Note: If the Adapter’s application folder contains files that were installed 
after the original install process, these files will not be deleted by the 
uninstall process. You must remove these files manually.
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Upgrading to Genesys Framework 7.5
See the Genesys 7 Migration Guide for details.

Upgrading to Genesys Outbound Contact 
7.5

See the Genesys 7 Migration Guide for details.

Importing the 7.5 Adapter Component 
Templates

Both the Adapter component, Campaign Synchronization Server (CSS), and 
the Autodialing Gateway Server for SAP (AGS) templates must be imported.

Importing the CSS Template

See “Importing the Application Template” on page 27 for details

Importing the AGS Template

See “Importing the Application Template” on page 45 for details.

Creating the 7.5 Adapter Component 
Applications

Both the Adapter component, Campaign Synchronization Server (CSS), and 
the Autodialing Gateway Server for SAP (AGS) application objects must be 
created.

Creating the CSS Application

See “Creating and Configuring the Application” on page 28 for details.

Creating the AGS Application

See “Creating the Application Object” on page 46 for details.
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Configuring the 7.5 Adapter Components
Both the Adapter component, Campaign Synchronization Server (CSS), and 
the Autodialing Gateway Server (AGS) objects must be configured.

Configuring the CSS Object

See “Preliminary Procedures” on page 27 for details.

Configuring the AGS Object

See “Configuring the Autodialing Gateway Server for SAP” on page 45 for 
details.

Installing the 7.5 Adapter Components
Both the Adapter component, Campaign Synchronization Server (CSS) and the 
Auto-dialing Gateway Server (AGS), objects must be installed.

Installing the CSS Object

See “Installing Campaign Synchronization Server” on page 41 for details.

Installing AGS Object

See “Installing Autodialing Gateway Server for SAP” on page 61 for details.

Starting the Adapter Components
See Chapter 8, “Starting the Adapter Components,” on page 65 for details.

Activating the SAP Calling Lists
See Chapter 9, “Use-Case Scenarios,” on page 71 for details.
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Chapter

4 Configuring Campaign 
Synchronization Server
This chapter describes how to configure the Campaign Synchronization Server 
(CSS). It includes the following sections:

Preliminary Procedures, page 27
Importing the Application Template, page 27
Creating and Configuring the Application, page 28
Configuring Security Settings, page 36
Creating the List Import Format, page 37

Preliminary Procedures
Before you configure CSS, you must configure the Genesys Framework 
applications. The required Genesys Framework applications are:
• Configuration Database
• Configuration Server
• Configuration Manager

Note: As a Configuration Manager user, you should have sufficient privileges 
to make changes to Configuration Layer objects.

Importing the Application Template
Before you install CSS, you must import the Application Template into 
Genesys Configuration Manager, and also create and configure an Application 
object based on this template.
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To import the CSS Application Template:
1. Open Configuration Manager, log in, and then select Environment > 

Application Templates.

2. Right-click Application Templates. 
3. From the shortcut menu that appears, select Import Application Template.
4. In the Open dialog box, navigate to the file for the CSS Application 

Template. Its location on your hard drive or installation CD may vary. The 
file name is: Campaign_Synchronization_Server_750.apd.

5. Select this file and click Open. The Properties dialog box for the 
Application Template object appears.

6. (Optional) Edit the Application Template name. 
7. In the Properties dialog box, click OK.
The Application Template object has been imported to Genesys Configuration 
Layer. Next, you will create the Configuration Layer Application object for the 
Campaign Synchronization Server.

Creating and Configuring the Application
After you have imported the template as described in the previous section, 
create and configure the new Primary and Warm Standby (optional) 
Application object(s). This involves the following tasks:
1. Creating the Application object
2. Configuring the General tab
3. Configuring the Tenants tab (in a multi-tenant environment)
4. Configuring the Server Info tab
5. Configuring the Start Info tab
6. Configuring the Connections tab 
7. Configuring the Options tab
8. Completing the initial setup of the Application object
9. Configuring the Security tab
10. Creating the List Import Format object

Creating the Application Object
To create the properties for the new Application object, use Configuration 
Manager’s Properties dialog box.
1. In Configuration Manager, select Environment > Applications.
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2. Right-click either the Applications folder or the subfolder where you want 
to create your application.

3. From the popup menu that appears, select New > Application.
4. In the Open dialog box, locate the template you just imported, and then 

double-click it.
5. Click OK. 
Configuration Manager opens the Properties dialog box for the new 
Application object as shown in Figure 2.

Figure 2: View of General Tab in Multi-Tenant Environment

Configuring the General Tab
To configure general information about the application, use the General tab of 
the Properties dialog box.
1. Click the General tab of the Properties dialog box.
2. (Optional) In the Name box, enter a name for the Application object. 
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Note: Next, if you are working in a multi-tenant environment, go to the 
Tenants tab; otherwise, go to the Server Info tab.

Configuring the Tenants Tab
If you are installing the Adapter in a multi-tenant environment, the Tenants tab 
is available in Configuration Manager. CSS works only with Tenants that are 
selected here.

Configuring the Server Info Tab
To configure the server information for the application, use the Server Info tab 
of the Properties dialog box.
1. Click the Server Info tab.
2. Select the Host that this instance of CSS is to run on.
3. Set the Communication Port field to any unused port (on this host).

Note: This option determines the HTTP port number used by CSS to 
receive HTTP packets from AGS. You will use the value that you 
enter for this option when you configure AGS.

Configuring the Start Info Tab
To configure the startup information for the application, use the Start Info tab 
of the Properties dialog box. 
1. Click the Start Info tab. 
2. In the Working Directory field, enter the full name of the Component 

installation directory on the host you specified on the Server Info tab. The 
value you enter in this field will be used as the default destination folder 
during installation. 

3. In the Command Line field, enter a period (.) to enable Setup to populate this 
field during installation.

4. In the Command Line Arguments field, enter a period (.) to enable Setup to 
populate this field during installation.

Note: The values you enter in the Command Line and Command Line 
Arguments fields will be overwritten during installation; however, 
data must be present in these fields during the configuration 
process.

5. Leave the default values for the remaining fields.
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Configuring the Connections Tab
On the Connections tab, add the applications to which this application 
connects.
1. Click the Connections tab.
2. Click Add to add a connection to the following Genesys servers:

Database Access Point—This option is used to provide access to the 
Calling List tables in the Outbound Contact database.
(Optional )Outbound Contact Server—This option is required if you 
plan the use the CancelRecord option.
(Optional) T-Server—This option is required if you plan the use the 
CancelRecord option. It is used by the Outbound Contact Server to 
communicate through the communication DN.
(Optional) Message Server—This option is required if you plan to use 
the Management Layer for alarm-signaling and centralized-logging 
capabilities.
(Optional) Configuration Server—This option is required if you plan to 
configure a connection to this server.

3. (Optional) Adjust the Advanced Disconnect Detection Protocol (ADDP) 
between CSS and Genesys servers components.

Configuring the Options Tab
This section describes the configuration options for CSS. You must configure 
all of the following sections before starting the Adapter:
• CallingListFolders
• CustomStatistics
• DatabaseAccessPoints
• Genesys
• Log
• TableAccessFolders
• Tenants
To set various configuration options for the application, use the Options tab of 
the Properties dialog box. You will configure options in these sections 
starting with the CallingListFolders section. Double-click a section to 
access its options.
Table 1 lists and describes the configuration options on the Options tab. These 
options are grouped according to the section of the tab in which they appear. A 
Yes in the “Must Restart?” column indicates that you must restart the Adapter 
after changing the option. A Yes in the “Must Set?” column indicates an option 
that you must configure in order for the Adapter to function properly. You can 
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accept the default values for all other configuration options or adjust them 
later, according to your needs.

Note: All option names and values are case-sensitive, so be sure to enter 
them exactly as shown in Table 1.

Table 1: Gplus Adapter Configuration Options

Option Name Values Description Must 
Restart?

Must 
Set?

CallingListFolders Section
Options in this section define the mapping of SAP subsystems to Genesys Calling Lists folders. To map a 

SAP subsystem to a Genesys Calling Lists folder, create a new option within this section, where the 
option name is the external <AdminLoginName> which corresponds to SAP subsystem and the option 

value is the name of the existing Calling Lists folders in Genesys CLE. (see “External Organizations and 
Administrators” on page 16).

Note: Prior to importing information from SAP, you must use Genesys Configuration Manager to create 
the Configuration Manager folders referenced in this section.

<AdminLoginName> Default Value: None
Valid Values: 
<CallingLists Folder>

Where, 
<CallingLists Folder> 
is the name of an 
existing Calling Lists 
folder in Genesys CLE. 

Each option in this section 
controls the mapping of an 
AdminLoginName used in the 
AGS XML- messages to a 
Configuration Manager 
folder, where the CSS will 
create corresponding 
configuration objects 
(Calling List objects) when 
importing from SAP. 

No Yes
Note: 
One 
option is 
required.

CustomStatistics Section
This section must contain options for each Outbound Contact Format filed that you plan to send as a 

statistic to SAP server by requests.
Note: The default options are required for SAP backward synchronization, and they must not be 

modified. You can add any other field from the Genesys Format Configuration Layer Environment 
(CLE) object used in CSS.

agent_id Default Value: 1
Valid Values: 
<any valid integer or 
string>

This option corresponds to 
the agent_id that is a 
Format Field object in the 
Genesys CLE. For more 
information, see the 
Outbound Contact 7.5 
Deployment Guide.

N/A No, this 
option 
must not 
be 
modified.



Campaign Synchronization for SAP—Deployment Guide 33

Chapter 4: Configuring Campaign Synchronization Server Creating and Configuring the Application

campaign_id Default Value: 1
Valid Values: 
<any valid integer or 
string>

This option corresponds to 
the campaign_id that is a 
Format Field object in the 
Genesys CLE. For more 
information, see the 
Outbound Contact 7.5 
Deployment Guide.

N/A No, this 
option 
must not 
be 
modified.

contact_info Default Value: 1
Valid Values: 
<any valid integer or 
string>

This option corresponds to 
the contact_info that is a 
Format Field object in the 
Genesys CLE. For more 
information, see the 
Outbound Contact 7.5 
Deployment Guide.

N/A No, this 
option 
must not 
be 
modified.

record_status Default Value: 1
Valid Values: 
<any valid integer or 
string>

This option corresponds to 
the record_status that is a 
Format Field object in the 
Genesys CLE. For more 
information, see the 
Outbound Contact 7.5 
Deployment Guide.

N/A No, this 
option 
must not 
be 
modified.

Table 1: Gplus Adapter Configuration Options (Continued) 

Option Name Values Description Must 
Restart?

Must 
Set?
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DatabaseAccessPoints Section
Options in this section define the mapping of SAP subsystems to Genesys Database Access Points. To 
map a SAP subsystem to a Genesys Database Access Points, create a new option within this section, 

where the option name is the external <AdminLoginName> which corresponds to SAP subsystem and 
the option value is the name of the existing Database Access Point in Genesys CLE. For more 

information, see “External Organizations and Administrators” on page 16.
Note: Prior to importing information from SAP, you must use Genesys Configuration Manager to create 

the Configuration Manager Database Access Points referenced in this section.

<AdminLoginName> Default Value: None
Valid Values: 
<DataAccessPoint>

Where, 
<DataAccessPoint> is the 
name of the existing 
Database Access Point 
from Genesys CLE.

The options in this section 
control mapping of the 
<AdminLoginName> used 
in the AGS XML- messages 
to a Configuration Manager 
Database Access Point.  The 
Database Access Point 
defines the OCS database 
where the CSS will create 
corresponding Calling List 
tables when importing data 
from SAP.

No Note: 
One 
option is 
required.

Genesys Section
This section contains miscellaneous options.

communicationDN Default Value: None
Valid Values: 
<communicationDN>

Where, 
<communicationDN> is 
the name of the existing 
Communication DN 
object from Genesys 
Configuration Layer 
Environment (CLE) 
object.

This option determines the 
name of the communication 
DN that the CancelRecord 
functionality will use for 
interactions with the 
Outbound Contact Server. 
Note: This option must be 
defined, if the 
sendCancelRecord option is 
set to true.

Yes Yes, if 
you want 
to use the 
Cancel-
Record 
function-
ality, and 
no 
otherwise 
(Y/N).

CancelRecordTimeout Default Value: 5000ms
Valid Values: 
<a valid positive 
integer>

This option sets the time 
interval that CSS will wait 
for a CancelRecord 
response from Outbound 
Contact Server (OCS).

Yes Y/N

Table 1: Gplus Adapter Configuration Options (Continued) 

Option Name Values Description Must 
Restart?

Must 
Set?
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format Default Value: 
GplusCampSynch

Valid Values: 
<FormatName>

Where, <FormatName> is 
the name of the existing 
Format object from 
Genesys CLE

This option determines the 
name of a list import Format 
object in the Genesys CLE. 
The Format object is used 
by the CSS to create 
Genesys calling list tables. 

Yes Yes

sendCancelRecord Default Value: false
Valid Values: 
true, false

This option manages the 
availability of the 
CancelRecord functionality.
If the option is true, the 
CancelRecord 
functionality is enabled.

If the option is false, the 
CancelRecord 
functionality is disabled.

Yes Y/N

Log Section
This section supports the unified set of log options (common log options) to enable precise configuration 
of the log file output. For a complete list of unified log options and their descriptions, see the “Common 

Log Options” chapter of the Framework 7 Configuration Options Reference Manual. If you do not 
specify any log options, the default values apply.

TableAccessFolders Section
Options in this section define the mapping of SAP subsystems to Genesys Table Access folders. To map 
a SAP subsystem to a Genesys Table Access folder, create a new option within this section, where the 
option name is the external <AdminLoginName> which corresponds to SAP subsystem and the option 

value is the name of the existing Table Access folders in Genesys CLE.
Note: Prior to importing information from SAP, you must use Genesys Configuration Manager to create 

the Configuration Manager folders referenced in this section.

<AdminLoginName> Default Value: None
Valid Values: 
<TableAccessFolderName>

Where, 
<TableAccessFolderName> 
is the name of the 
existing Genesys Table 
Access folder name.

Each option in this section 
controls the mapping of an 
AdminLoginName used in the 
AGS XML- messages to a 
Configuration Manager 
folder, where the CSS will 
create corresponding 
configuration objects (Table 
Access objects) when 
importing from SAP. 

No Yes
Note: 
One 
option is 
required.

Table 1: Gplus Adapter Configuration Options (Continued) 

Option Name Values Description Must 
Restart?

Must 
Set?
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Completing the Initial Application Setup
Once the values in the previous subsections have been entered, click OK to 
complete the application setup. 

Configuring Security Settings
Security settings must be configured for the Campaign Synchronization Server 
so that CSS can make changes to Genesys Configuration Layer objects. Follow 
the procedures outlined in the following sections to configure the security 
settings for the Application object you created in “Creating and Configuring 
the Application” on page 28.

Creating a New Person
In Configuration Manager:
1. If you are working in a multi-tenant environment, right-click the Persons 

folder under Environment. If you are working in a single-tenant 
environment, right-click the Persons folder under Resources.

2. Select New > Person. The new Person window appears.
3. Select the General tab 

Employee ID: CSS_Admin_use 
User Name: CSS_Admin_user 
Is Agent: Clear 

4. Click OK.

Tenants Section
Options in this section define the mapping of SAP Organizations to Genesys Tenants. To map a SAP 

Organization to a Genesys Tenant, create a new option within this section, where the option name is the 
name of the Genesys Tenant and the option value is the name of the SAP Organization defined in AGS. 

<TenantName> from 
Genesys CLE.

Default Value: None
Valid Values: The SAP 
Organization name 
defined in the 
corresponding AGS.

This option maps SAP 
Organizations to Genesys 
Tenants.

No Yes
Note: 
One 
option is 
required.

Table 1: Gplus Adapter Configuration Options (Continued) 

Option Name Values Description Must 
Restart?

Must 
Set?
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Adding a Person to the Super Administrators Access Group
In Configuration Manager, to display the existing Access Groups:
1. Click the Access Groups folder under Environment if you are working in 

a multi-tenant environment or under Resources if you are working in a 
single-tenant environment.

2. Double-click Super Administrators Access Group to display its properties.
3. Click the Add button to add the Person you just created to the Users list.
4. Click OK.

Associating a Person's Account with the Application
In Configuration Manager, under Environment:
1. Click the Applications folder to display existing Applications.
2. Double-click the Application object you just created to display its 

properties.
3. Select the Security tab, in the Log On As section, and select This Account. 

The Add User window appears.
4. Select the Person you just created and click Add.
5. Click OK to close the Add User window.
6. Click OK to save the Application object.

Creating the List Import Format
In this step of the configuration process, you create a list import Format object. 
The list import Format object determines the structure of the calling list tables 
that CSS will create when importing SAP campaigns. Creating the list import 
Format object involves three processes:
• Creating Field Objects
• Creating the Format Object
• Copying the Format Object
The first step of the process is to create several Field objects that are 
mandatory for each list import Format.
Before you create the Field objects, however, make sure that the Annex tab will 
be displayed in the Configuration object Properties window:
1. In Configuration Manager, select Options from the View menu.
2. Select Show Annex tab in object properties. 
3. Click OK to close the window. 



38 Gplus Adapter 7.5

Chapter 4: Configuring Campaign Synchronization Server Creating the List Import Format

Creating Field Objects
To create a new Field object, in Configuration Manager:
1. Right-click the Fields folder. If you are working in a multi-tenant 

environment, this is located under Environment; if you are working in a 
single-tenant environment, this is located under Resources.
The New Field Properties window appears.

2. Select New > Field. The new Field window appears. 
3. On the General tab, for the Field you are creating, enter the Name field value 

from Table 2. 
For example, to complete the first instance, enter crm_camp_con_id.

4. On the Annex tab, create a new section called default. 
5. In the default section, create an option with the option name 

send_attribute and the option value from Table 3, which corresponds 
to the Field object you are creating.

6. Click OK. 
Table 2 contains properties you need to enter on the General tab for each Field 
object. 

Table 3 shows an example value for the send_attribute option, which you 
can use when creating Field objects. 

With this configuration all Outbound calls would have the following key:value 
pair:
SAP_CALL_ID:<value of corresponding crm_camp_con_id field>

Table 2: Field Object Properties

Field Name Data 
Type

Description Length Field Type Primary 
Key

Nullable

crm_camp_con_id varchar SAP PDCALL 
GUID 

32 User-
Defined 
Field

Selected Cleared

Table 3: Values for the send_attribute Option

Field Name send_attribute Option Value

crm_camp_con_id SAP_CALL_ID
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Creating the Format Object
Now you are ready to create the Format object. Follow these steps, in 
Configuration Manager:
1. Right-click the Formats folder under Environment if you are working in a 

multi-tenant environment or under Resources if you are working in a 
single-tenant environment.

2. Select New > Copy of existing Format. 
3. In the Browse window, select the default format for Outbound Contact:

Default_Outbound_70.

4. Click OK. The Properties dialog box for the Format copy that you are about 
to create appears. 

5. Enter the following values on the General tab: 
Name: GplusCampSynch (this name should be the same as defined in the 
format option on Page 35)
Description: Default list import format for the Gplus Adapter 7.5 
for SAP Campaign Synchronization Component.

6. Click OK. 
7. In Configuration Manager, in the object tree view, right-click the Format 

object you just created.
8. Select New > Shortcut to Field. The Browse window appears.
9. Select the Field objects you just created.
10. Click OK. 

Note: You can add other User-Defined Fields (as required for your business).

Copying the Format Object
If you work in a multi-tenant environment, create a copy of the list import 
Format object under each Tenant that you will use.
To make a copy of the Format object:
1. In Configuration Manager, under a tenant that is mapped to a SAP 

Organization or Division, right-click the Formats folder. 
2. Select New > Copy of existing Format. The Browse window appears.
3. Select the Format object you just created.
4. Click OK. The Properties dialog box appears for the Format copy that you 

are about to create. 
5. Click OK to copy the Format. 
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5 Installing Campaign 
Synchronization Server
This chapter describes how to install and uninstall the Campaign 
Synchronization Server (CSS). It includes the following sections:

Installing the CSS, page 41
Uninstalling the CSS, page 43

Installing the CSS
Install the Adapter on the target computer by using an InstallShield program 
that takes you step-by-step through the installation process.

Running the Setup
To install the Adapter on the target machine:
1. Insert the Gplus Adapter 7.5 Campaign Synchronization for SAP 

installation CD into your CD-ROM drive.
The autorun feature is activated. After a few moments, an autorun Welcome 
window opens, as shown in Figure 3. If the window does not open, see 
“Starting the Installation Manually”.
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Figure 3: Autorun Welcome Window

2. To view the product’s Readme file, click the Readme file link.
3. To exit the installation utility, click Exit Installation Utility.
4. To install the CSS, click Campaign Synchronization Server. 
5. Proceed to “Installing the Adapter”

Starting the Installation Manually

If your CD-ROM drive is not configured to employ autorun for CDs, after 
inserting the Gplus Adapter 7.5 Campaign Synchronization for SAP 
installation CD into your CD-ROM drive, install CSS on the target machine 
using the Setup program:
1. Locate the setup.exe file in the CD path 

\gplus_components\campaign_synchronization_server\windows\ or 
find the setup file in your installation package.

2. Double-click setup.exe to run the InstallShield Wizard.
3. Proceed to “Installing the Adapter”

Installing the Adapter

After you have chosen to install the Adapter, InstallShield takes you through 
the installation process step-by-step.
1. After InstallShield prepares the Genesys Installation Wizard, the Welcome 

window appears. 
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2. Read the text, and click Next to proceed. 
3. The Connection Parameters to the Genesys Configuration Server dialog 

box appears. Enter the required information, and click Next to continue.
4. The Select Application dialog box appears. It contains a list of 

Application objects from the Configuration Server database which have a 
template of type Genesys Generic Server and Server Info corresponding 
to the host on which the installation is running. Select the application you 
just created, and click Next to continue.

5. The Choose Destination Location dialog box appears. Keep or change the 
default destination and click Next to continue.

6. The Ready to Install dialog box opens. Click Install to begin copying 
files.

7. Wait for Setup to finish copying files.
8. When the Installation Complete window appears, click Finish to 

complete the installation.
By default, CSS is installed as a Genesys service (Windows Services) with an 
Automatic startup type.

Note: If you plan to run CSS as a Windows NT Service, you should become 
familiar with the common recommendations about deploying Genesys 
components as Windows NT Services. These recommendations are 
available in the Genesys Framework 7.5 Deployment Guide.

Installation Results
After the Setup has successfully completed, you will see:
• A Genesys Campaign Synchronization Server entry has been added to the 

Windows Services list. 
• The Adapter Application object Start Info tab parameters are populated.

Uninstalling the CSS
Uninstall CSS using the Microsoft Windows Add/Remove Programs feature.

Note: Stop the Adapter before it is uninstalled.

Note: The uninstall procedure varies, depending on the version of the 
Windows operating system that you are running. Keep this in mind as 
you complete the following procedure.
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To completely uninstall CSS:
1. From the Windows main taskbar, select Start > Settings > Control 

Panel > Add/Remove Programs.

2. Select Genesys Campaign Synchronization Server 7.5.xxx.xx (where 
xxx.xx is the exact version that you have installed) as the component to 
remove.

3. Follow the instructions on screen, and confirm that you want to remove 
CSS.

4. After you see the message that says that the uninstall has been completed, 
follow the instructions on screen to conclude the uninstall process.

Note:  If the CSS folder contains files that were not initially installed, these 
files will not be deleted by the uninstall process. You must remove 
these files manually.
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6 Configuring the Autodialing 
Gateway Server for SAP
This chapter describes how to configure the Autodialing Gateway Server 
(AGS) for SAP. It includes the following sections:

Preliminary Procedures, page 45
Importing the Application Template, page 45
Creating and Configuring the Application, page 46
Configuring and Creating the AGS Internal Table, page 55
Configuring the SAPphone Server in SAP, page 56

Preliminary Procedures
Before you configure AGS, you must configure the Genesys Framework 
applications. The required Genesys Framework applications are:
• Configuration Database
• Configuration Server
• Configuration Manager

Note: As a Configuration Manager user, you should have sufficient privileges 
to make changes to Configuration Layer objects.

Importing the Application Template
Before you install AGS, you must import the Application Template into 
Genesys Configuration Manager, and also create and configure an Application 
object based on this template.
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To import the AGS Application Template:
1. Open Configuration Manager, log in, then select Environment > 

Application Templates.

2. Right-click Application Templates. 
3. From the shortcut menu that appears, select Import Application 

Template.

4. In the Open dialog box, navigate to the file for the AGS Application 
Template. Its location on your hard drive or installation CD may vary. The 
file name is Autodialing_Gateway_Server_750.apd. 

5. Select this file and click Open. The Properties dialog box for the 
Application Template object appears.

6. (Optional) Edit the Application Template name.
7. In the Properties dialog box, click OK.
The Application Template object has been imported to Genesys Configuration 
Layer. Next, you will create the Configuration Layer Application object for the 
Autodialing Gateway Server for SAP.

Creating and Configuring the Application
After you have imported the template as described in the previous section, 
create and configure the new AGS Application object. This involves the 
following tasks:
1. Creating the Application object
2. Configuring the General tab
3. Configuring the Server Info tab
4. Configuring the Start Info tab
5. Configuring the Connections tab
6. Configuring the Options tab
7. Completing initial setup of the Application object

Creating the Application Object
To create the properties for the new Application object, use Configuration 
Manager’s Properties dialog box.
1. In Configuration Manager, select Environment > Applications.
2. Right-click either the Applications folder or the subfolder where you want 

to create your application.
3. From the popup menu that appears, select New > Application.
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4. In the Open dialog box, locate the template you just imported, then double-
click it.

Configuration Manager opens the Properties dialog box for the new 
Application object as shown in Figure 4.

Figure 4: Configuration Manager’s Properties Dialog Box 

Configuring the General Tab
To configure general information about the application, use the General tab of 
the Properties dialog box.
1. Click the General tab of the Properties dialog box.
2. (Optional) In the Name box, enter a name for the Application object. 

Figure 5 shows the contents of the General tab with the application name 
changed to AGS_for_SAP.
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Figure 5: Configuration Manager’s General Tab

Configuring the Server Info Tab
To configure the server information for the application, use the Server Info tab 
of the Properties dialog box.
1. Click the Server Info tab.
2. Select the Host that this instance of AGS is to run on and click OK.
3. Set the Communication Port field to any unused port (on this host).
An example of Server Info tab settings is shown in Figure 6.



Campaign Synchronization for SAP—Deployment Guide 49

Chapter 6: Configuring the Autodialing Gateway Server for SAP Creating and Configuring the Application

Figure 6: Configuration Manager’s Server Info Tab

Configuring the Start Info Tab
To configure the startup information for the application, use the Start Info tab 
of the Properties dialog box.
1. Click the Start Info tab. 
2. In the Working Directory field, enter a period (.) to allow Setup to 

populate this field during installation. 
3. In the Command Line field, enter a period (.) to allow Setup to populate this 

field during installation.
4. Do not enter a value in the Command Line Argument field. The installation 

program will provide the correct data for this field.
An example of Start Info tab settings is shown in Figure 7.
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Figure 7: Configuration Manager’s Start Info Tab 

Configuring the Connections Tab
On the Connections tab, add the applications to which this application 
connects.
1. Click the Connections tab.
2. Click Add to add a connection to the following Genesys servers:

Message Server (optional, for logging messages to the network)
Configuration Server (optional)
Database access point (to allow access to the DB storage for internal 
AGS needs)
Campaign Synchronization Server

3. Adjust the Advanced Disconnect Detection Protocol (ADDP) between 
AGS and Genesys servers components (optional).
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Configuring the Options Tab
This section describes the configuration options for AGS. You must configure 
all of the following sections before starting the Adapter:
• log 
• rfc-server
• General 
• CampSync 
To set various configuration options for the application, use the Options tab of 
the Properties dialog box. You will configure options in these sections 
starting with the log section. Double-click a section to access its options.
Table 4 lists and describes the options on the Options tab. These options are 
grouped according to the section of the tab in which they appear. A Yes in the 
“Must Restart?” column indicates that you must restart the Adapter after 
changing the option. A Yes in the “Must Set?” column indicates an option that 
you must configure in order for the Adapter to function properly. You can 
accept the default values for all other configuration options or adjust them 
later, according to your needs.

Note:  All option names and values are case sensitive, so be sure that you use 
the correct case as shown in Table 4.

Table 4: AGS Configuration Options

Option Name Values Description Must 
Restart?

Must 
Set?

log Section
This section supports the unified set of log options (common log options) to enable precise configuration of the log 
file output. For a complete list of unified log options and their descriptions, see the “Common Log Options” chapter 

of the Framework 7 Configuration Options Reference Manual. If you do not specify any log options, the default 
values apply.

rfc-server Section
Contains options affecting the RFC server. The SAP system administrator should provide all SAP-related settings.

gateway-host Default Value: None
Valid Values: <valid host 
name>

Host name or host string of 
the SAP Gateway. For 
example: 
/H/192.168.3.215/H/204.7
9.180.5/S/3298/H/cpce601

No Yes

gateway-service Default Value: None
Valid Values: <valid 
service>

Service of the SAP gateway 
(For example: sapgw13)

No Yes
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program-id Default Value: None
Valid Values: <Program ID in 
RFC destination that is 
used in SAPphone server>

Program ID of the AGS 
(RFC destination)

No Yes

listen-timeout Default Value: 1
Valid Values: <1 through 
120>

Timeout value (in seconds) No Yes

recv-thread Default Value: 1
Valid Values: <1 through 
512>

The minimum number of 
threads that are awaiting 
incoming requests. If the 
number of threads becomes 
less than specified because 
some thread is busy handling 
requests, AGS will create 
additional threads.

No Yes

send-thread Default Value: 1
Valid Values: <currently 
undefined>

Reserved for future use. No Yes

reconnect-timeout Default Value: 4
Valid Values: <any positive 
integer>

Defines (in seconds) how 
long AGS waits before trying 
to connect to the SAP 
gateway if the connection 
was broken.

No Yes

connection-pool Default Value: 1
Valid Values: <1 through 
128>

The maximum number of 
open (but not necessarily 
listening) connections.

No Yes

General Section
Specifies the general options.

TIMEZONE Default Value: GMT
Valid Values: Time zone name 
in Genesys CME.

Time zone is transferred to 
the CSS if it is not provided 
by SAP.

No Yes

Table 4: AGS Configuration Options (Continued) 

Option Name Values Description Must 
Restart?

Must 
Set?
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STARTTIMEEX Default Value: 080000
Valid Values: HHMMSS or -1

The value of the daily_from 
field is transferred to the 
CSS.
HH is the digit value between 
00 and 23 inclusively.
MM is the digit value 
between 00 and 59 
inclusively.
SS is the digit value between 
00 and 59 inclusively.
If this option is set to -1, the 
Adapter will transfer the 
value provided by SAP. Any 
non-valid value will be 
treated as -1.

No Yes

ENDTIMEEX Default Value: 180000
Valid Values: HHMMSS or -1

The value for the daily_to 
field is transferred to the 
CSS.
HH is the digit value between 
00 and 23 inclusively.
MM is the digit value 
between 00 and 59 
inclusively.
SS is the digit value between 
00 and 59 inclusively.
If this option is set to -1, the 
Adapter will transfer the 
value provided by SAP. Any 
non-valid value will be 
treated as -1.

No Yes

DB_Table Default Value: 
AGS_INTERNAL_TABLE

Valid Values: valid table 
name

The table name, which is 
located in the DataBase 
specified in the Database 
Access Point under the 
Connection tab of AGS. This 
table is where AGS saves the 
internal data (see 
“Configuring and Creating 
the AGS Internal Table” on 
page 55).

No Yes

Table 4: AGS Configuration Options (Continued) 

Option Name Values Description Must 
Restart?

Must 
Set?
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Agent_name_subst Default Value: 
NAME_CUT_BY_OCS

Valid Values: valid for SAP 
agent name

The agent name is transferred 
to SAP when the Genesys 
agent name is too long. The 
current SAPphone limit is 15 
characters.

No Yes

CampSync Section
Specifies the CSS specific options

Organization Default Value: 
Valid Values: <the name of 
the existing Tenant>

The name of the Tenant 
where AGS is running. Under 
this Tenant, CSS creates the 
Calling List and Table Access 
objects.

No Yes

Admin Default Value: 
Valid Values: <any character 
string>

The name of the Super 
administrator in CSS.

No Yes

ConnectionTimeout Default Value: 60000
Valid Values: <any positive 
integer>

The timeout, in milliseconds, 
for requests to be sent to 
CSS.

No Yes

(Optional) HW_DISP Section
This section overrides the default mapping of Genesys call results to the SAP HW_DISP key.

Note: This section is not provided in the template. It must be added manually.

<customOptionName>

Where, 
<customOptionName> is 
the Genesys call result 
integer value. For more 
information, see the 
Genesys Outbound 
Contact 7.5 Reference 
Manual.

Default Value: None
Valid Values: 
<customOptionValue>

Where, the 
<customOptionValue> is the 
value of the HW_DISP (string). 
For more information, see the 
SAPphone documentation.

This option specifies custom 
mapping between the 
Genesys Call Result value 
and the SAP HW_DISP key. 
Create one option for each 
Genesys Call Result value 
that requires a custom SAP 
HW_DISP key.
For example: If 
<customOptionName>= 28 and 
<customOptionValue>= BUSY, 
then records with a 
CallResult = 28 will be sent 
to SAP as HW_DISP= BUSY.

No No
This 
option is 
optional. 
If it is not 
defined, 
then the 
hard-
coded 
mapping 
will be 
used.

Table 4: AGS Configuration Options (Continued) 

Option Name Values Description Must 
Restart?

Must 
Set?
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Completing the Initial Application Setup
Once the values in the previous subsections have been entered, click OK to 
complete the application setup.

Note: Also see “Configuring the SAPphone Server in SAP” on page 56 for 
options that you must configure for the AGS to function properly.

Configuring and Creating the AGS Internal 
Table

A Database Access Point for the AGS Internal Table must be added to the 
AGS connections. The AGS Internal Table name is configured in the DB_Table 
option in the General section (see “DB_Table” on page 53). AGS installation 
provides the SQL scripts for supported databases that should be executed 
manually after you install and before the you uninstall, if required to manage 
the AGS Internal Table. See “Configuring the Database”. The AGS SQL 
scripts come with the AGS Internal Table name set to AGS_INTERNAL_TABLE.

Note: Multiple AGS instances should use different AGS Internal Tables.

Configuring the Database
You must configure the appropriate database management system (DBMS) to 
run the Autodialing Gateway Server for SAP. The application and other names 
used in the following procedure are examples. You can use these names or 
create others to suit your business needs.
To configure the DBMS:
1. Create a new database (genesys_adapter_sap_outbound, for example) in the 

DBMS.
2. Run the appropriate script for your database. You will find the script in the 

Genesys directory you created during the setup process, for example, 
<DISK>:\GCTI\Autodialing Gateway Server for SAP\scripts. For 
information about executing an SQL script, see your database 
documentation.
The database is now configured.

Note: If you want to use a different name for the AGS internal table, you 
should edit the corresponding SQL script and specify the new 
name in the DB_Table option.
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Uninstalling the AGS Internal Table
Before uninstalling the AGS, you should remove the AGS internal table. To 
remove the AGS internal table run the appropriate uninstall script for your 
database. For information about executing an SQL script, see your database 
documentation.

Note: If you have used your own name in step 2, you should edit the 
corresponding SQL script ags_uninstall_mssgl.sql or  
ags_uninstall_ora.sql and specify the table name used in step 2 (see 
“Configuring the Database”).

Configuring the SAPphone Server in SAP
The SAPphone Server must be configured. Follow the procedures outlined in 
the following section.

Component Enabling Examples 
This section describes the two tasks you must complete on the SAP side to 
enable the AGS component:

1 “Configure the RFC Connection (Transaction SM59)” on page 56.

2 “Configure CTI Server in SAPphone (Transaction SPHB)” on page 57.

Configure the RFC Connection (Transaction SM59)

To configure the RFC Connection you must create a new RFC destination. 

Creating a New RFC Destination

To create a new RFC Destination (see Figure 8):

1 Specify a name for the RFC destination. 

Note: SAPphone refers to this name, as described in “Configure CTI 
Server in SAPphone (Transaction SPHB)” on page 57.

2. Set Connection Type (Figure 8) to T. 

3 Register an RFC Server Program at a SAP gateway, or connect to an 
already registered RFC Server Program.

4 (Optional) Enter a Description (see Figure 8).
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Figure 8: RFC Connection Configuration

5. Click the Test connection button, located at the top-left corner in Figure 8, 
to check connectivity through the configured RFC connection. 

Note: The AGS component on the Genesys side must be running.

Configure CTI Server in SAPphone (Transaction 
SPHB)

You must configure SAPphone because this interface is used to pass data 
back and forth between Genesys and SAP CRM.

The RFC Destination for SAPphone must match the entry defined for the RFC 
connection (see “Configure the RFC Connection (Transaction SM59)” on 
page 56).
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Create a New SAPphone Server

To create a SAPphone server (see Figure 9):

1. Specify a Server name.

2. Enter a Description. 

3. Enter the RFC destination that connects to the AGS component.

Note: You may define the RFC settings. Click the RFC maint. button

4. Select Server in use.

5.  Under the Functions column, select Dialer.

[

Figure 9: Creating a SAPphone Server
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6. After you enter all the data, click Connection test to display the valid 
version, as shown in Figure 10.

Figure 10: Connection Test Results 
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7 Installing Autodialing 
Gateway Server for SAP
This chapter describes how to install the Autodialing Gateway Server (AGS) 
for SAP. It includes the following sections:

Installing the AGS, page 61
Uninstalling the AGS, page 63

Installing the AGS
Install the Adapter on the target computer by using an InstallShield program 
that takes you step-by-step through the installation process.

Running the Setup
To install the Adapter on the target machine:
1. Insert the Gplus Adapter 7.5 Campaign Synchronization for SAP 

installation CD into your CD-ROM drive.
The autorun feature is activated. After a few moments, an autorun Welcome 
window opens, as shown in Figure 11. If the window does not open, see 
“Starting the Installation Manually”.
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Figure 11: Autorun Welcome Window

2. To view the product’s Readme file, click the Readme file link.
3. To exit the installation utility, click Exit Installation Utility.
4. To install AGS, click Autodialing Gateway Server for SAP. 
5. Proceed to “Installing the Adapter”

Starting the Installation Manually

If your CD-ROM drive is not configured to employ autorun for CDs, after 
inserting the Gplus Adapter 7.5 Campaign Synchronization for SAP 
installation CD into your CD-ROM drive, install the AGS on the target 
machine using the Setup program:
1. Locate the setup.exe file in the CD path 

\gplus_components\autodialing_gateway_server\windows\ or find the 
setup file in your installation package.

2. Double-click setup.exe to run the InstallShield Wizard.
3. Proceed to “Installing the Adapter”

Installing the Adapter

After you have chosen to install the Adapter, InstallShield takes you through 
the installation process step-by-step.
1. After InstallShield prepares the Genesys Installation Wizard, the Welcome 

window appears. 
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2. Read the text, and click Next to continue. 
3. The Connection Parameters to the Genesys Configuration Server dialog 

box appears. Enter required information, and click Next to continue.
4. The Select Application dialog box appears. It contains a list of 

Application objects from the Configuration Server database which have a 
template of type Genesys Generic Server and Server Info corresponding 
to the host on which the installation is running. Select the application, and 
click Next to continue.

5. The Choose Destination Location dialog box appears. Keep or change the 
default destination and click Next to continue.

6. The Ready to Install dialog box appears. Click Install to begin copying 
files.

7. Wait for Setup to finish copying files.
8. When the Installation Complete window appears, click Finish to 

complete the installation. 
By default, AGS is installed as a Genesys service (Windows Services) with an 
Automatic startup type.

Note: If you plan to run the AGS as a Windows NT Service, you should 
become familiar with the common recommendations about deploying 
Genesys components as Windows NT Services. These 
recommendations are available in the Genesys Framework 7.5 
Deployment Guide.

Installation Results
After the Setup has successfully completed, you will see:
• A Genesys Autodialing Gateway Server for SAP entry is added to the 

Windows Services list. 
• The Adapter Application object Start Info tab parameters are populated.

Uninstalling the AGS 
Uninstall the AGS using the Microsoft Windows Add/Remove Programs feature.

Note: Stop the Adapter before it is uninstalled.

Note: The uninstall procedure varies, depending on the version of the 
Windows operating system that you are running. Keep this in mind as 
you complete the following procedure.
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To completely uninstall the Adapter components:
1. From the Windows main taskbar, select Start > Settings > Control Panel 

> Add/Remove Programs.
2. Select Genesys Autodialing Gateway Server for SAP 7.5.xxx.xx 

(where xxx.xx is the exact version that you have installed) as the 
component to remove.

3. Follow the instructions on screen, and confirm that you want to remove the 
AGS.

4. After you see the message that says that the uninstall has been completed, 
follow the instructions on screen to conclude the uninstall.

Note:  If the AGS folder contains files that were not initially installed, these 
files will not be deleted by the uninstall process. You must remove 
these files manually.
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Chapter

8 Starting the Adapter 
Components
This chapter describes how to start the Gplus Adapter Campaign 
Synchronization for SAP. It includes the following sections:

Launching the Adapter Components from the Start Menu, page 66
Starting the Adapter Components Using the Solution Control Interface, 
page 67
Starting the Adapter Components as a Windows Service, page 68

You can start both Adapter components, Autodialing Gateway Server (AGS) 
and Campaign Synchronization Server (CSS), in one of the following ways:
•   Using a shortcut from the Start Menu
•   Using an executable file from Windows Explorer (with Command Line 

  Arguments)
•   Using the Application object configured in Configuration Manager from the 

  Solution Control Interface
•   Using the Windows Service object found in the Windows Services console.

Note:  Before you start the Adapter components, make sure that all Genesys 
components (Configuration Server, Database Server, and so on) 
required by the Adapter components are properly configured and 
running.
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Launching the Adapter Components from 
the Start Menu

Both Adapter components (CSS and AGS) can be started from the Windows 
Start menu.

Starting CSS

To launch CSS from the Start menu in Windows:
• Select Start > Programs > Genesys Solutions > Campaign 

Synchronization Server [<application>] and select Start CSS.
When the CSS component starts, the CSS console window appears with 
log information (initialization steps, and so on) as shown in Figure 12. The 
specific information displayed will vary.

Figure 12: The Adapter’s CSS Component Started Successfully 
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Starting AGS

To launch AGS from the Start menu in Windows:
• Select Start > Programs > Genesys Solutions >Autodialing Gateway 

server for SAP [<application>] and select Start AGS.
When the AGS component starts, the AGS console window appears with 
log information (initialization steps, SAP requests, error info, and so on) as 
shown in Figure 12. The specific information displayed will vary.

Figure 13: The Adapter’s AGS Component Started Successfully 

Starting the Adapter Components Using 
the Solution Control Interface

Both Adapter components (CSS and AGS) can be started from the Genesys 
Solution Control Interface.
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Starting CSS

If you adjust integration with the Management Layer, you will also able to start 
the CSS and check log information remotely using the Solution Control 
Interface application.
To launch CSS from the Solution Control Interface:
1. Make sure that the Local Control Agent is running on the host where the 

CSS is installed.
2. Make sure that the Start Info tab of Adapter Application object in 

Configuration Manager has correct startup parameters specified.
3. In the Solution Control Interface, in Items Tree view, find the CSS 

Application object you created in previous steps.
4. Start the CSS using the Start menu shortcut or the Start button on the 

toolbar.

Starting AGS

If you adjust integration with the Management Layer, you will also be able to 
start the AGS and check log information remotely using the Solution Control 
Interface application.
To launch AGS from the Solution Control Interface:
1. Make sure that the Local Control Agent is running on the host where the 

AGS is installed.
2. Make sure that the Start Info tab of AGS Application object in 

Configuration Manager has correct startup parameters specified.
3. In the Solution Control Interface, in Items Tree view, find the AGS 

Application object you created in previous steps.
4. Start the AGS using the Start menu shortcut or the Start button on the 

toolbar.

Starting the Adapter Components as a 
Windows Service

Both Adapter components (CSS and AGS) can be started from the Windows 
Services console.
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Starting CSS

To launch CSS from the Windows Services console:
During installation on Windows, create an entry for the CSS component in the 
Windows Services list. By default this entry has Automatic startup type. 
Therefore, CSS is automatically started each time a computer on which it is 
installed is rebooted. 
The CSS component may also be started manually using the Windows Services 
Console as follows:
1. Open the Administrative Tools panel by double-clicking the 

Administrative Tools icon.
2. Open the Services window by double-clicking the Services icon.
3. Start or stop CSS by right-clicking and selecting Start or Stop from the 

shortcut menu.

Note: For debug purposes you can select the Allow service to interact 
with desktop checkbox on the Log On tab of the service’s properties. 
This will open the CSS component’s console window where you can 
see the real-time log messages generated by CSS.

Starting AGS

To launch AGS from the Windows Services console:
During installation on Windows create an entry for the AGS component in the 
Windows Services list. By default this entry has Automatic startup type. 
Therefore, the AGS is automatically started each time a computer on which it 
is installed is rebooted. 
The AGS component may also be started manually using the Windows 
Services Console as follows:
1. Open the Administrative Tools panel by double-clicking the 

Administrative Tools icon.
2. Open the Services window by double-clicking the Services icon.
3. Start/stop AGS by right-clicking and selecting Start or Stop from the 

shortcut menu.

Note: For debug purposes you can select the Allow service to interact 
with desktop checkbox on the Log On tab of the service’s properties. 
This will open the AGS component’s console window where you can 
see the real-time log messages generated by AGS.
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Chapter

9 Use-Case Scenarios
This chapter provides specific use-case scenarios for using the Adapter. It 
includes the following sections:

Testing the Adapter-SAPphone Connection, page 71
Setting Up and Assigning the Call List, page 72
Running Campaign Record Deletion, page 78

Testing the Adapter-SAPphone Connection
After you have started the Adapter components (CSS and AGS), Genesys 
recommends that you perform a connection test. In this way you will be able to 
check the connection and compatibility between the Adapter components and 
SAP, and the Adapter will receive some information about your SAPphone 
server settings.
To perform a connection test:
•   Go to transaction SPHB in your SAP system, select your site and telephony 

  server, and click Connection test. In the dialog box that appears you 
  should see the SAPphone version implemented in the Adapter and supported 
  by your SAP system as shown in Figure 14.

Figure 14: Connection Test Has Passed
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Setting Up and Assigning the Call List
Note: The following scenario is only an example. The behavior may vary in 

different SAP systems.

To set up a Call List:
1. Log in to SAP CRM. 
2. From the SAP CRM menu, select [Interaction Center > Supporting 

Processes >] Call Lists > Call List Maintenance.

Note: The exact path depends on the version of SAP CRM you are using.

3. Select the Call List that is to be transferred to Genesys.
You must also assign the Call List to at least one resource. For example, 
the Call List shown in Figure 15 on page 73 is assigned to an agent.
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Figure 15: Transferring a Call List from SAP to Genesys

To transfer a Call List from SAP to Genesys:
1. Set the Execution Mode to Automated. A line to select a dialer appears. All 

servers defined in the SAPphone that are configured as dialer are presented 
in the drop-down list.

2. Select the dialer defined to connect to Genesys using an RFC connection.
3. Click Activate (the button labeled 1 in Figure 15) to activate the Call List. 

Clicking this button also activates the Deactivate (labeled 2 in Figure 15) 
and Synchronize (labeled 3 in Figure 15) buttons.

1 2 3
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The corresponding objects are created in the Genesys Configuration database. 
See Figure 16.

Figure 16: Call List Objects in the Genesys Configuration Database
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The corresponding Call List table is created in the Genesys database. You can 
find the name of this table using the Table Access object. See Figure 17.

Figure 17: Genesys Database Table
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The content of the Call List is transferred over to the Genesys database. See 
Figure 18.

Figure 18: Transferring the Call List to the Genesys DB

4. You can assign the Genesys Calling List to any available campaign and 
process it. See Figure 19.

Note: A SAP Campaign is equivalent to a Genesys Calling List.
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Figure 19: Genesys Calling List Details View

5. Press the Synchronization button (see button 3—Figure 15 on page 73).
The statistical information is transferred from Genesys to SAP. See 
Figure 20.



78 Gplus Adapter 7.5

Chapter 9: Use-Case Scenarios Running Campaign Record Deletion

Figure 20: Genesys Call List Maintenance 

6. After you are finished with the Call List, click Deactivate (labeled 2 in 
Figure 15) to disable the Call List.

Running Campaign Record Deletion
The Adapter enables running-campaign records to be deleted from a SAP 
Campaign even when the campaign is already running on the Genesys side. 
The following configuration is required for this functionality to work:
1. CSS must have a connection to the T-Server and the Outbound Contact 

Server. For more information, see “Configuring the Connections Tab” on 
page 31.

The following CSS options must be set in the CSS Application object’s 
Genesys section:

sendCancelRecord equals true
communicationDn equals the number of Communication DNs on the 
switch that is used to run the outbound campaign.
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This functionality could be useful in the following use cases: 
1. You have already transferred campaign data from SAP to Genesys
2. The correspondent outbound campaign is active and running on the 

Genesys side.
3. The record from the correspondent Genesys calling list is already being 

processed by OCS. For example, the agent requested this record. 
4. The correspondent call is marked as Completed in the SAP Campaign.
5. There is a request to delete this record on the Genesys side. 
In this case CSS:
1. Submits a CancelRecord request to OCS through T-Server's communication 

DN. 
2. Deletes the correspondent record from the Genesys Calling List tables.
This behavior corresponds to the Genesys OCS Cancel Record approach. For 
more information, see the Outbound Contact 7.5 Reference Manual.
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